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Quick Start

How many knobs does it take to turn on eight green LEDs?
One...but at least read this section to avoid unwelcome jokes.

Architectural look. Since Decora plates come in differ-
ent colors, each SR 4 is shipped with 3 different color labels for
installation behind the lens (we ship them without an insert
installed). Colors included are white (w/ black logo), almond (w/
black logo) and black ( w/ white logo) which accommodate most
applications. The label has a transparent window so custom selec-
tion lists can be seen. Custom selection lists are easily created
using a Microsoft Word™ template or the SR Label Maker ap-
plication included on the Drag Net CD-ROM or downloadable
from www.rane.com/sr4.html.

Addpress. Set the Device Address rotary switch on the side of
the SR 4; addresses from 0 through 7 are valid. Each device con-
nected to the same RS-485 bus must have a unique address.

Wiring. Use CAT 5 cable with a minimum of 2 twisted
pairs to connect to the SR 4. The use of DOG 4 cable may cause
random barking in high traffic areas (another joke, couldn't
resist). Connect one twisted pair of wires to the “-V” and “+V”
terminals — “-V” must connect to the power supply ground
and “+V” must connect to +8 to +15 volts. Connect the second
twisted pair of wires to the “A” and “B” terminals; “A” connects
to the RS-485 “data +” connection and “B” connects to the RS-
485 “data —” connection. When shielded CAT 5 cable is used, a
chassis terminal is provided for shield termination.

Setup software. The SR 4 is configured using Drag Net soft-
ware included in the box or available at www.rane.com/dragner.
html. See “Working with Smart Remotes” on page Manual-3.

WEAR PARTS: This product contains no wear parts. It also contains no wash and wear parts.

SMART REMOTE
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Front Panel Description

@ Paper insert lays behind the Lexan label, and may be created with a Microsoft
Word™ template or the SR Label Maker application. These are found on the Drag \

N
J

Custom
paper
insert
slips
behind
the
Lexan
window

Net CD-ROM or downloadable at www.rane.com/sr4.html.

@ Lexan label 3 colors included: white (w/black logo), almond (w/black logo) and l

black (w/white logo).

@3 Clear lens helps support different color templates which mount behind the lens.
@ LED indicators. Indicate the current “level” of the linked parameter(s).

(@ Encoder Knob with momentary push switch is the user input to the SR 4.

Rear Panel Description
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@) Device Address switch to assign the device its RW 485

address. Addresses 0 through 7 are valid.

@ 6-wire Euroblock connector. Connects the SR 4 to a

controller. A connects to RS-485 data +, B connects to
RS-485 data —. +V is the positive side of the power supply
rail. -V is the negative/ground side of the power supply
rail. Ground is the connection point for the shield when
shielded cable is used. When the Encoder Lock pin is
grounded and Auto Lock is enabled, encoder input is
ignored by the SR 4. This, for example, allows a keyed
switch to be installed next to the SR 4 that allows the de-
vice to be “locked” so only keyholders can change system
volume.



Working with Smart Remotes

Smart Remote Overview

Users familiar with Rane’s SR Configurator program rejoice:
Smart Remotes are now configured entirely within Drag Net
4.0! SR Configurator is no longer used and can be uninstalled,
preferably with some kind of accompanying ritual or chant.

The following sections describe configuring the various
parameters and modes for the remotes themselves. Details on
assigning remotes to control parameters and functions with an
RPM are found in Drag Net’s included Help file (Help > Help
Topics).

Creating a new Configuration

Smart Remote configurations can be created as offline Stor-
age files, for subsequent transfer to a Live remote. To create a
new Smart Remote Configuration:

1. Click the File menu, choose New, then select Configuration
(CTRL + N).

- or - Click the New Configuration button in the standard j
toolbar.

- or - Right-click within the Project window and select New,

then Configuration (CTRL + N).

2. Select the configuration source, either from an empty
configuration, or from an existing Rane- or User-defined
template. Select a device type from the Configuration Type
list to filter the list of file options (to only show SR 3 files in
the User Template directory, for example). Selecting the Copy
Settings check box copies all parameters to the new configu-
ration. This is a particularly useful feature when creating new
configurations based on existing User Templates.

3. Select a configuration type (SR 2, SR 3, SR 4) from the list of
choices.

4. Click Next

5. Enter a Name, storage location on your hard drive, and brief
description of the configuration.

6. Click Finish and start configuring the remote!

File extensions for Smart Remote configurations follow the
remote type — SR 2 configurations are stored as .sr2 files, for
example.

Each remote has a number of configuration parameters
which determine basic functions and user operation modes.
These parameters are stored locally on each remote in non-vola-
tile memory.

SR 4 Configuration Parameters

The SR 4 features a 31-position LED indicator, rotary data
encoder with integrated push switch, and a column of eight
green LED indicators for selection status. Custom selection lists
are easily created using the included Microsoft Word template
or SR 4 Label Maker application. The printed list is then placed
beneath the transparent window of the SR 4 ’s faceplate insert,
and held firmly in place by a plastic lens.

Auto Lock

Auto Lock is used in conjunction with the SR’s Encoder
Lock pin to disable the SR encoder. When the Encoder Lock pin
is grounded and Auto Lock is enabled, changes in position of
the encoder are ignored by the SR. For example, a keyed switch
installed next to the SR allows the device to be locked temporar-
ily so the system volume can not be adjusted.

Knob Turn

When Auto Level is enabled and the encoder is turned
normally (without pushing it in) the LED moves clockwise or
counterclockwise one position in the direction the knob was

turned. Always enable Auto Level when using a Smart Remote
with a Rane RPM device.

Knob Push & Turn

When Auto Selection is enabled and the encoder is held in
and turned, the vertical selection LED moves vertically amongst
the choices.

When Selection Roll is enabled the selection wraps around
from last to first (or first to last, depending on the direction the
encoder was turned).

When Update on Release is enabled, the SR updates its
Selection index when the encoder is released, rather than updat-
ing each time the encoder is turned. This feature allows users to
scroll through selections, choose the selection they want, then
release the encoder to trigger the action (for example, recall a
Preset on an RPM 88).

Knob Bump

When Auto Selection is enabled and the encoder is pressed
in and released (without turning), the next Selection is automarti-
cally chosen; the Selection index is updated after the Update
Timer expires. Note: Selections automatically roll from last to
first while in Bump mode.

The Update Timer determines how long the SR 4 waits
before updating its Selection index once the encoder is released.
Setting this value to 0 updates the index instantly, with every
press/release combination of the encoder. Increasing this value
allows users to scroll through and preview selections without
updating the index on every press. The valid range for the timer
is 0 to 5 seconds.

Max Num Selections

Max Num Selections limits the number of selections acces-
sible by the user. For example, if Max Num Selections is set to
4, the user is only able to access Selections 1 to 4, even though
there are 4 other Selections (total of 8) stored on the SR 4. Max
Num Selections only applies when an Auto Selection mode is

bled.
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Polling for Remotes
Ethernet versus Serial Communication

If Smart Remotes are connected to an RPM device, the RPM
acts as a data bridge, allowing communication with the remote
through the Ethernet connection to the RPM. Smart Remotes
appear beneath the RPM device in the Live folder of the Project
window.

Serial communication takes place through the PC’s COM
port, which is usually RS-232 and therefore must be connected
to the SR using an RS-232 (unbalanced data) to RS-485 (bal-
anced data) converter capable of supporting the desired baud
rate. Rane makes a suitable device - namely the DSC 1. Select
the COM port connected to the SR from the list of available
ports when polling for Live devices.

Baud Rate

The Baud Rate can only be set when Serial Mode is selected
during polling. When configuring Remotes used with Rane con-
trollers (i.e., RPM 88/44/22), the RW 485 baud rate of 38400
bps is automatically set. Should you encounter communication
problems, settings can be restored to 38400 baud, 10 ms delay
by holding the encoder in while powering the remote. Release
the encoder when its LED lights.

Transferring Configurations to and from a Live Remote

Remotes can be configured offline in Storage mode, then
transferred to a Live remote when you get to the job site. Al-
ternately, you can transfer the contents of a Live remote to an
offline Storage configuration as a backup, or for editing when
you're back in the comfy chair at the office.

Storage to Live

Live remotes are initialized by transferring a Storage configu-
ration to a Live remote. This action replaces all settings on the
remote. Once the transfer is complete you can continue to work
directly with the Live remote, adjusting mode parameters, insert-
ing bitmaps (SR 3), and so on. Hint: You'll need to Poll for Live
devices before transferring configurations. To transfer a Storage
remote configuration to a Live device:

1. Toggle the Project Window on if it’s not already visible (View
> Project).

2a. Drag and drop the Storage configuration listed under the
Storage folder onto a destination remote listed under the Live
folder.

- or -

2b. Select the Storage configuration, click the Transfer Config
To button, and then select a destination remote from the list.

- or -

2c. Righe-click the Storage configuration and choose Transfer
To, then select a destination remote from the list.

Live to Storage
Important: Transferring from a Live remote to an existing
Storage configuration overwrites the Storage configuration.
To transfer from a Live remote to a Storage configuration:
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1. Toggle the Project Window on if it’s not already visible (View
> Project).

2a. Drag and drop the Live remote onto an existing destination
Storage configuration.

-of -

2b. Select the Live remote, click the Transfer Config To but-
ton, and then select a destination Storage configuration from
the list, or choose to create a new configuration.

-of -

2c¢. Right-click the Live remote and choose Transfer To, then
select the destination Storage configuration from the list, or
choose to create a new configuration.

Editing a Live Remote

It is possible to edit any parameter on a Live remote directly,
without first having to transfer a Storage configuration to it.

To view the current contents of a Live remote simply double-
click the remote listed under the Live folder of the Project Win-
dow. Alternately, right-click the Live remote and choose Open
item. The contents of the Live remote are then loaded into the
Device Configuration window for viewing and/or editing.

Renaming a Remote
To rename a Smart Remote:
1. Right-click the Live remote in the Project window and
choose Properties.
2. Enter a new name for the remote in the Name field.

Updating Smart Remote Firmware

It may be necessary to update a Smart Remote’s firmware in
order to add features or address one of those pesky glitches that
only seem to appear after the product’s been released.

Remotes with the following firmware versions can be upgrad-
ed as new firmware becomes available:

Remote With Firmware Version
SR 2 2.0 and higher
SR 3 4.0 and higher
SR 4 1.0 and higher

Older remotes may not be updateable, or updateable only by
Rane. Contact Rane Tech Support 425-355-6000 or visit www.
rane.com for more information.

Firmware files for all remotes are installed as part of Drag
Net and are located in the Program Files\Rane Corporation\
Drag Net\Firmware\Smart Remotes directory.

To update firmware in a Smart Remote:

1. Ensure remotes are properly connected to the RPM device.
Remotes must be connected before powering the RPM on.

2. Connect directly to the RPM device, using an Ethernet cross-
over cable.

3. Poll to find the Live device. Remotes are listed beneath the
RPM device in the Project window.

4. Select the Remote to be updated.

5. Launch the Update Device Firmware Wizard (Tools >
Update Device Firmware).

6. Follow the wizard’s on-screen instructions to complete the op-
eration. The device automatically resets itself once the update
is complete.

Firmware updates performed using a COM Port (Serial) fol-
low the exact same steps, beginning with Step 3.



(o 12t0 15VDC

regulated
power
supply:
Radio Shack
273-1691
or equivalent.

SR 4 Wiring Guidelines

Restrictions

24 AWG CAT 5 cable resistance = 26 ohms per 1,000 feet. There are two wiring restric-
tions. First, RW 485 has a maximum of 1,000 feet. The total length may not exceed this limit
in any combination of series or parallel runs.

Second, the voltage of the power supply also affects the maximum distance of each length
between, and the number of Remotes. Refer to the tables on the following pages depending on
which wire, voltage, number of Remotes, and if you are using single or multiple runs.

External Power Supply

The RPM 88’s RW 485 port does not offer enough current to power more than six SR 4
remotes — an external DC supply must be used. Rane recommends using a 12 to 15 volt DC
regulated power supply capable of delivering a minimum of 1 amp of current. The combined
current draw on the RPM 88’s RW 485 port and VOP cannot exceed 375 milliamps. [The
RPM 44 and RPM 22, however, can power up to eight SR 4 remotes.]

Most installations will have a mix of SR 2, SR 3, and SR 4 remotes each with their own
current requirements. To make calculation easy as to whether or not an external supply is nec-
essary, a Microsoft Excel™ spreadsheet is available named SRXCABLELENGTH.XLS. This
file is on the Drag Net CD-ROM, or downloadable from www.rane.com/sr2.html.

If you have a Radio Shack nearby, they offer a 15 volt 1 amp supply, catalog number:
273-1691. To ease installation, use a 6 foot Adaptaplug extension cable, Radio Shack catalog
number 273-1641.

Radio Shack
273-1641
Adaptaplug
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Cable Type 1

REGULATED
POWER
SUPPLY

REMOTE INTERFACE PORT

(RW 485)
I_ 1

(Faais]

REGULATED
POWER
SUPPLY

RPM
REMOTE INTERFACE PORT

(RW 485)
I_ 1

A B +V -V &

Max Distance | Max Distance for Number of
2 twisted pair unshielded CAT 5, Belden #1588(A,R) for Cable (feet) | Cable (meters) | SR 4 Remotes
2 twisted pair unshielded CAT 5, Belden #1590A Vs =15V 1000 305 1
RPM 44 1000 305 2
RPM 22 769 235 3
Single Run Distance (Series) 599 183 4
1 d2 —— d3 — 490 149 5
S S S 415 126 6
359 110 7
o o o 317 97 8
k5 k5 k5
dT |
Vs =12V 1000 305 1
Single run restriction: Total cable length RPM 88 672 205 2
d1+d2+d3 = dT <769 ft (per table example) 481 147 3
374 114 4
Multiple Run Distances (Star) 306 93 5
& S S Requires 259 79 6
° ° ° external 225 68 7
v W _ﬁ_ supply 198 60 8
= = Vs =8V 224 68 1
134 41 2
o o 96 29 3
e R 75 23 4
d2 ’ 61 19 5
S 52 16 6
45 14 7
gr 40 12 8
d3 | Note: This table is only for systems using SR 4 remotes (all remotes on 485 bus are the same).

Multiple run restriction (per table entries): d1 <769 ft, d2 <1,000 ft, d3 <1,000 ft
Total cable length must be under 1,000 ft: d1 + d2 + d3 = dT <1,000 ft

RPM

REMOTE INTERFACE PORT

(RW 485)
[ ]

A B +V -V 7

nnnhE

For mix and match calculation of SR 2, SR 3 and SR 4 Remotes, use the SRCABLELENGTH.XLS
Microsoft Excel™ spreadsheet on the Drag Net CD-ROM or at www.rane.com/sr4.html.

ADDRESS 7 _

SR
MADE INUSA
RANE CO RP.

Examples:

Soif

d1=400 ft (<769 ft, OK)

d2=300 ft (<1,000 ft, OK)

d3=200 ft (<1,000 ft, OK)
d1+d2+d3=900 ft, then it's all OK!

SR
MADE INUSA
RANE CO RP.

butif

d1=500 ft (<769 ft, OK)

d2=400 ft (<1,000 ft, OK)

d3=300 ft (<1,000 ft, OK)
d1+d2+d3=1,200 ft, then it's NOT OK!

MADE INUSA
RANE CO RP.

BELDEN #1588 (AR) -
BELDEN #1590 (A) L TZ|C Yo
BLUE BLUE
WHITE/BLUE WHITE/BLUE
ORANGE ORANGE @ E
WHITE/ORANGE WHITE/ORANGE
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Cable Type 2

4 twisted pair unshielded CAT 5, Belden #1583(A, B, E, ENH, R)
4 twisted pair shielded CAT 5, Belden #1624 (P, R)

4 twisted pair unsheilded CAT 5, Belden #1700 (A, R)

REGULATED Single Run Distance (Series)
POWER
SUPPLY — d1 —— d2 —— d3 —
S S S
REMOTE INTERFACE PORT o o o
e EGE e e
A B +V -V M"I dT f

Single run restriction: Total cable length
d1+d2+d3 = dT <1,000 ft (per table example)

Multiple Run Distances (Star)

& & &
REGULATED o o o
POWER el d1 el 1"?"‘-
SUPPLY
& &
o o
e k=
d2 |
RPM
REMOTE INTERFACE PORT Ry
'—(RW 485) —|
A B +V -V & o
@ e
d3 |

Max Distance | Max Distance for Number of

for Cable (feet) | Cable (meters) | SR 4 Remotes
Vs =15V 1000 305 1
RPM 44 1000 305 2
RPM 22 1000 305 3
1000 305 4
1000 305 5
1000 305 6
1000 305 7
952 290 8
Vs =12V 1000 305 1
RPM 88 1000 305 2
1000 305 3
1000 305 4
919 280 5
Requires 778 237 6
external 674 205 7
supply 595 181 8
Vs =8V 671 205 1
403 123 2
288 88 3
224 68 4
184 56 5
156 47 6
135 41 7
119 36 8

Note: This table is only for systems using SR 4 remotes (all remotes on 485 bus are the same).

For mix and match calculation of SR 2, SR 3 and SR 4 Remotes, use the SRCABLELENGTH.XLS
Microsoft Excel™ spreadsheet on the Drag Net CD-ROM or at www.rane.com/sr4.html.

More conductors mean greater operating distance.

Multiple run restriction (per table entries): d1 <1,000 ft, d2 <1,000 ft, d3 <1,000 ft

Total cable length must be under 1,000 ft: d1 + d2 + d3 = dT <1,000 ft

Examples:
Soif

d1=400 ft (<1,000 ft, OK)
d2=300 ft (<1,000 ft, OK)
d3=200 ft (<1,000 ft, OK)

d1+d2+d3=900 ft, then it's all OK!

RPM
REMOTE INTERFACE PORT

(RW 485)
[ 1

A B +V -V 77

ninn

butif

d1=500 ft (<1,000 ft, OK)
d2=400 ft (<1,000 ft, OK)
d3=300 ft (<1,000 ft, OK)
d1+d2+d3=1,200 ft, then it's NOT OK!

BELDEN #1583 (A, B, E, ENH, R)
BELDEN #1624 (P, R) *Shielded
BELDEN #1700 (A, R)

WHITE/GREEN

*SHIELD

BLUE
WHITE/BLU

ORANGE |
WHITE/ORANGE

ADDRESS 7

R Tl
1111

L1l

T
o
[0

WHITE/GREEN
BROWN

WHITE/BROWN
*SHIELD

=]
encoo entoc

FAC

SR

SR
MADE INUSA
RANE CO RP.

SR
MADE INUSA
RANE CO RP.

MADE INUSA
RANE CO RP.

=
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DSC 1

This pages illustrates connection of a computer running Drag
Net or a controller to SR 4(s) via RS-232 using the Rane DSC 1
(plus external power).

Note, earlier versions of the DSC 1 do not support the
faster baud rates of the SR 4. DSC 1’s with date codes later than
4/2001 should be used to guarantee carefree communications.
The date code is found on the bottom of the DSC 1.

]

2=RED RED=2
3=BLACK BLACK=3 3
5=SHIELD SHIELD=5

21 2=RED RED=3
22 3=BLACK BLACK=2 3
23 7=SHIELD SHIELD=5
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DSC1 DSC1

DB-9 male to DB-9 female DB-25 male to DB-9 female

ADDRESS 7 _

8-15VDC i

REGULATED Vs 3
POWER N o b
SUPPLY ! —[-1-|—

=

d¥02 INVY (dI¥) L4Od
VSN NIV @ JOVAUILNI
ENTIER]

PORT (RIP)

REMOTE INTERFA(

43

A B AV A
ENCOUERLOCd
SR
MADE IN USA.
RANE CORP.

L

W >
ADDRESS

+V

RN
11
A
[

20222

ADDRESS 1

RANE

DSC 1
DIGITAL —
SERIAL

CONVERTER

REMOTE INTERFA(
PORT (RIP)

A B AV
ENCODERLOCj
SR
MADE IN USA.
RANE CORP.

L

g3

INPUT
RS 232 DATA

ADDRESS

ADDRESS 0

REMOTE INTERFA(
PORT (RIP)

A B4V A
ENCODER LOCd
SR
MADE IN USA.
RANE CORP.

L

ce

RS-232 FROM

COMPUTER OR -
CONTROLLER '
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SR 4 Communication Protocol

The SR 4 communication protocol follows Rane’s RW 485 specification. The following describes the SR 4 implementation.

Physical

The baud rate is 38,400 bps with No parity, 8 Data Bits, 1 Stop Bit (N81) format. The SR 4 also supports 9600, 19200, 57600, and 115200 bps.
When configuring Remotes used with Rane controllers (RPM 22, 44, 88), the RW 485 baud rate of 38400 bps is required. At the end of a com-
mand message, the Master must release the bus within 10 ms. The SR 4 waits this length of time before transmitting its response. To restore the
SR 4 communication settings to 38400 baud 10 ms delay, apply power while pushing the encoder iz for several seconds until the encoder LED
illuminates.

Master/Slave

RW 485 is a master/slave bus network, with only one master in charge, which we define as the Protocol Master (controller). When the Protocol
Master expects a response from a slave, it relinquishes control of the bus, allowing the slave to drive the RS-485 bus.

The slave must then release the bus back to the Protocol Master, and we start again. The SR 4 is always a slave.

Value Encoding
All numeric values are represented in ASCII decimal format separated by commas.
Values with the MSB set ($80 or larger) are interpreted as potential device addresses.

Syntax
Command messages are sent from the Protocol Master to the SR 4. Response messages are returned to the Protocol Master from the SR 4. The SR
4 always responds to the Protocol Master upon receiving a complete command message at the correct baud rate.

Command and response messages have the same format:
message = <addr> <msgtype> <devtype> <checksum> <command/data> <CR>

<addr> Each device has a unique address in the range [0, 7]. The encoding is one byte with the MSB set.

For example, if the SR 4’s address switch is set to 5, the controller would send 10000101. ($5 + $80)
The SR 4 always returns its address switch setting plus $80. ($addr + $80)
The address switch must be set in the range [0, 7].

<msgtype> The msgtype is a one byte set of flags indicating options, bit 7=MSB:
bit 0) set = checksum is valid
bit 1) set = there has been an error (response only)
bit 2-5)  reserved, cleared to 0
bit 6) always 1
bit 7) always 0

If the controller wants the SR 4 to verify the checksum, it would send a value of $41, or an ASCII ‘A’. If the controller wants the SR 4 to ignore
the checksum, it would send a value of $40, or an ASCII ‘@’.
The SR 4 echoes back the <msgtype> it was sent. In the case of an error, the SR 4 sets bit 1.

<devtype> The SR 4 device type value is $33, or an ASCII ‘3’. The SR 4 also accepts a value of $30, or an ASCII ‘0’, the universal device type
used for polling.

The SR 4 always returns its device type of $33.

<checksum> The checksum is defined as the sum of the ASCII encoded values of the <command/data> section. The sum is then masked with
$007F to produce one byte with the MSB set to zero.

The controller would send a valid checksum as defined above if it sent a value of $41 for the <msgtype>. The SR 4 then verifies the sent check-
sum by calculating the checksum from the data it received in the <command/data> section of the sent message. On the other hand, if the
controller sent a value of $40 for the <msgtype> the SR 4 ignores the sent checksum. The controller must always send a checksum less than or
equal to $7F, even if it intends for the SR 4 to ignore it.

The SR 4 <checksum> response is based on the <msgtype> it was sent. If the SR 4 received a <msgtype> of $41, it returns a valid checksum
(as defined) calculated from it’s response data. If the SR 4 received a <msgtype> of $40, it returns zero.
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<command/data> The general format is <cmdl,argl,arg2,...,cmd2,argl,...>. The commas are part of the <command/data> structure and act
as delimiters between the ASCII encoded commands and data. Concatenation of commands is limited to four commands. Text string argu-
ments are delimited with quotes ("String"). If the string argument contains quotes, an accent character (%) placed in the string argument will
be interpreted by the SR 4 as a double quote character ("). The ASCII value for the accent character is $60, not to be confused with a single
quote character ('), ASCII value $27. For example: string argument: "A string that contains 'quotes’ " is interpreted as: A string that contains
"quotes".

The controller sends commands/arguments for the SR 4 to process. This section of the message is limited to 40 characters for the SR 4. See the
SR 4 Command Set section for details of valid commands.
The SR 4 responds with response data based on the commands/arguments it was sent. The SR 4 limits its response data to 40 characters. In the
case of an error, the response data is: n,"ERROR" where n is an error code defined below:

Hex ASCII  Error Code Meaning

$31 T Sent <devtype> invalid.

$32 2! Sent <checksum> did not verify.

$33 '3 Sent <command/data> parse error.

$34 '4' Sent <command/data> greater than 40 characters, or the number of concatenated commands >4.
$35 '5' Response <command/data> greater than 40 characters.

See the SR 4 Command Set section below for details of valid SR 4 responses.
<CR> A carriage return ($0D) terminates every message.
SR 4 Command Set
This section details the <command/data> portion of a complete RW 485 message. The SR 4 supports 10 commands. Below is a table of com-

mands and associated responses, followed by descriptions.

Configuration Commands

Cmd Arg(s)* Description Response**
A\ Get Firmware, Hardware Version nl,n2,"OK"
N ["cce..."] Read/Write Device's Name "cce...","OK"
SPL nl[,n2] Read/Write Stored Parameter n,"OK"

Input Commands

ILD [n1] Read/Write LED Enable nl,"OK"

ILK [n1] Read/Write Input Lock nl,"OK"

1Q Input Query nl,n2,"OK"

IR Input Raw nl,n2,n3,n4,"OK"
IS nl,n2 Input Suggest nl,n2,"OK"

ISR nl,n2 Input Suggest Raw nl,n2,n3,n4,"OK"
IF nl,n2 Input Force "OK"

* [ ] denotes optional Command Argument
** Responses from concatenated commands produce only one "OK"
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Configuration Commands

\"/
Get Firmware, Hardware Version
Send: V
Response: n1,n2,"OK"
Where:  nl is a two digit ASCII encoded decimal value representation of the firmware version. The first digit is the major
firmware version and the second digit is the minor firmware version.
n2 is a one digit ASCII encoded decimal value representation of the hardware version.
Example: 13,2,"OK" means firmware version 1.3, hardware version 2.
N

Read/Write Device's Name
The device’s name is limited to 32 characters and is stored in non-volatile memory. The default name is SR 4.

To read the device’s name:
Send: N
Response: "ccc”,"OK"
Where: ccc is the device’s name.
Example: "SR 4","OK" means the device’s name is SR 4

To write a new name to the device:
Send: N,"cec"
Where: ccc is the new name.
Example: N,"Conference Room 101" will rename the device to Conference Room 101

Response: "OK"

SPL

Read/Write Stored Parameter

Various configuration parameters are stored in non-volatile memory. This command reads and writes these parameters. For details of each param-
eter, see the Stored Parameter List section following the Command Set section.

To read a stored parameter value:
Send: SPL,n1
Where: nl is the stored parameter index.
Example: SPL, 1 indexes the first parameter in the list which is the Auto Level parameter.
Response: n1,"OK"
Where: nl is the value of the indexed parameter.
Example: 1,"OK" means that Auto Level is enabled.

To write a stored parameter value:
Send: SPL,n1,n2
Where:  nl is the stored parameter index.
n2 is the value to be stored.
Example: SPL,1,0 sets Auto Level parameter to 0, disabling the Auto Level function.
Response: "OK"
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Encoder Input Commands

ILD

Read/Write Encoder LED Enable byte

Reads or writes the Encoder LED Enable byte.
To read the LED Enable byte:

Send: ILD
Response: n1,"OK"
Where: nl is the Encoder LED Enable byte. The range is [0, 1].
Example: 1,"OK" means that the level LED indication is enabled.
To write the LED Enable byte:
Send: ILD,n1
Where: nl is the Encoder LED Enable byte. The range is [0, 1].
Example: ILD,0 disables LED indication.
Response: "OK"

ILK

Read/Write Software Input Lock

Reads or writes the input encoder software lock byte. The format of the lock byte is as follows: bit 0 set locks the level (no action when encoder is

turned), bit 1 set locks the selection (no action when the encoder is pushed in and turned), bit 2 set locks the enter state (no enter command state
change when the encoder is pushed and released without turning). This lock byte is volatile, meaning upon power up of the device the software

lock byte is always cleared to zero.

To read the Software Input Lock byte:
Send: ILK
Response: n1,"OK"

Where: nl is the Software Input Lock byte. The lock byte range is [0, 7].
Example: 3,"OK" means that both the level and selection are locked.

To write the Software Input Lock status:
Send: ILK,n1

Where: nl is the Software Input Lock byte. The lock byte range is [0, 7].

Example: ILK,2 locks the selection.
Response: "OK"

1Q
Input Query
Returns the current level and selection. Resets the command state to No Operation.
Send: IQ
Response: n1,n2,"OK"
Where:  nl is the current level. The level range is [1, 31].
n2 is the current selection. The selection range is [1, 8].

Example: 15,4, "OK" means that the current level is 15 and the current selection is 4.

IR
Input Raw

Returns the current level, selection, command state, and the length of time the encoder button has been pressed. Resets the command state to No

Operation.

Send: IR

Response: n1,n2,n3,n4,"OK"
nl is the current level. The level range is [1, 31].
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Where:

n2 is the current selection. The selection range is [1, 8].

n3 is the current command state. The command state represents the state of the encoder.
The possible states follow:

The encoder has been pushed in and released without being turned.

0 No Operation The encoder has not changed.

1 Encoder Left The encoder has been turned counter clockwise.

2 Encoder Right The encoder has been turned clockwise

16 Selection Left The encoder has been pushed in and turned counter clockwise.

32 Selection Right The encoder has been pushed in and turned clockwise.

64 Enter
n4 is the length of time the encoder button has been pressed. The time the button has been pressed is in units of .01
seconds and the range is [0, 255] or 0 to 2.55 seconds. The button timer starts at the press of the button and is reset
to zero when the button is released.

Example: 1,2,32,100,"OK" means the current level is 1, the current selection is 2, the current command state byte is a

Selection Right and the button has been held in for 1 second.



IS
Input Suggest
Suggests new level and selection. Resets the command state to No Operation.
If Auto Level is enabled, the level is updated and indicated by the encoder LED only if the device’s level has not changed by someone turning the
encoder. Otherwise, if Auto Level is disabled, the level is updated and indicated by the encoder LED regardless of encoder input.
If either Auto Selection is enabled (“knob push and turn” or “knob bump”), the selection is updated and indicated by the column of LEDs only if
the device’s selection has not changed by local encoder action. Otherwise, if neither Auto Selection is enabled, the selection is updated and indi-
cated regardless of encoder input.
Send: IS,n1,n2
Where: nl is the suggested new level. The level range is [0, 31]. If nl is zero, the level remains unchanged.
n2 is the suggested new selection. The selection range is [0, 8]. If n2 is zero, the selection remains unchanged.
Example: IS,3,5 suggests a new level of 3 and a new selection of 5.
Response: n1,n2,"OK"
Where: nl is the current level. The level range is [1, 31].
n2 is the current selection. The selection range is [1, 8].
Example: 3,5,"OK" means the current level is 3 and the current selection is 5. This means the suggested level and selection
were updated. A response of 10,5,"OK" means the current level is 10 and was last changed by someone turning the encoder
and the current selection was updated to 5.

ISR
Input Suggest Raw
Same operation as IS Input Suggest except ISR returns the command state byte and button time. Suggests new main level and second level. Resets
the command state to No Operation.
If Auto Level is enabled, the level is updated and indicated by the encoder LED only if the device’s level has not changed by someone turning the
encoder. Otherwise, if Auto Level is disabled, the level is updated and indicated by the encoder LED regardless of encoder input.
If either Auto Selection is enabled (“knob push and turn” or “knob bump”), the selection is updated and indicated by the column of LEDs only if
the device’s selection has not changed by local encoder action. Otherwise, if neither Auto Selection is enabled, the selection is updated and indi-
cated regardless of encoder input.
Send: ISR,n1,n2
Where:  nl is the suggested new level. The level range is [0, 31]. If nl is zero, the level remains unchanged.
n2 is the suggested new selection. Selection range is [0, 8]. If n2 is zero, the selection remains unchanged.
Example: ISR,3,5 suggests a new level of 3 and a new selection of 5.
Response: n1,n2,n3,n4,"OK"
Where:  nl is the current level. The level range is [1, 31].
n2 is the current selection. The selection range is [1, 8].
n3 is the current command state. The command state represents the state of the encoder.
The possible states follow:

0 No Operation The encoder has not changed.

1 Encoder Left The encoder has been turned counter clockwise.

2 Encoder Right The encoder has been turned clockwise

16 Selection Left The encoder has been pushed in and turned counter clockwise.

32 Selection Right The encoder has been pushed in and turned clockwise.

64 Enter The encoder has been pushed in and released without being turned.

n4 is the length of time the encoder button has been pressed. The time the button has been pressed is in units of .01
seconds and the range is [0, 255] or 0 to 2.55 seconds. The button timer starts at the press of the button and is reset
to zero when the button is released.
Example: 3,5,0,0,"OK" means the current level is 3, the current selection is 5, the current command state byte is a
No Operation and the button is not pushed in. This means the level and selection were updated. A response of
3,7,32,100,"OK" means the current level was updated to 3, the current selection is 7 and was last changed by someone
pushing in and turning the encoder, the current command state byte is a Selection Right, and a non-zero button time means
someone is still holding the button in.

IF
Input Force
Forces new level and selection. Resets the command state to No Operation.
The level is updated and indicated by the encoder LED regardless of Auto Level configuration.
The selection is updated and indicated by the column of LEDs regardless of Auto Selection configuration.
Send: IF,n1,n2
Where:  nl is the new level. The level range is [0, 31]. If nl is zero, the level remains unchanged.
n2 is the new selection. The selection range is [0, 8]. If n2 is zero, the selection remains unchanged.
Example: IF,3,5 sets a new level of 3 and a new selection of 5.

Response: "OK"
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Stored Parameter List (SPL)

Below is a table of stored parameters followed by descriptions of each parameter.

Index | Description Range of Values | Factory Setting | Meaning

1 Auto Level 0-1 1 disabled - enabled

2 | Auto Selection - Knob Push & Turn 0-1 1 disabled - enabled

3 | Auto Lock 0-1 1 disabled - enabled

4 Baud Rate 0-4 2 0 =9600, 1 = 19200, 2 = 38400, 3 = 57600,
4 =115200

5 | RW 485 Transmit Delay 2 —200 10 2 -200 ms

6 | Maximum Number of Selections 1-8 8 1 — 8 Selections, ignored if SPL 2 & 9
disabled.

7 | Knob Push & Turn Selection Roll 0-1 0 disabled - enabled

8 [ Knob Push & Turn Update on Release 0-1 1 disabled - enabled

9 | Auto Selection - Knob Bump 0-1 0 disabled - enabled

10 | Knob Bump Update Timer 0-5 3 0 - 5 seconds, ignored if SPL 9 disabled.

Parameter Descriptions

1. Auto Level configuration affects the result of turning the encoder.
Turning the encoder without pushing it in updates the command
state to an Encoder Left for a counter clockwise turn or an Encoder
Right for a clockwise turn unless the device is locked. If Auto Level
is enabled (a value of 1), the level is updated and indicated by the
encoder LED as well. The Auto Level configuration also affects the
Encoder Input Commands IS and ISR. See Encoder Input Com-
mands section for details.

2. Auto Selection - Knob Push & Turn configuration affects the result
of turning the encoder while it is pushed in. Turning the encoder
while pushing it in updates the command state to a Selection Left
for a counter clockwise turn or a Selection Right for a clockwise turn
unless the device is locked. If Auto Selection is enabled (a value of
1), the selection is updated and indicated by the column of LEDs as
well. The configuration of this parameter also affects the Encoder
Input Commands IS and ISR. See Encoder Input Commands sec-
tion for details.

3. Auto Lock configuration affects the operation of the device when the
lock input is shorted to -V. If the device is configured for Auto Lock
(a value of 1) and the Lock input is shorted to -V, the encoder is
locked out regardless of the software lock status (see ILK command).
If the device is not configured for Auto Lock (a value of 0), the
Lock input is ignored and the encoder’s lock state is defined by the
software lock status.

4. This parameter sets the baud rate of the device. When this parameter
is changed via a RW 485 message, the response is sent at the current
baud rate, then the baud rate is updated to the new baud rate speci-
fied by the value sent. The default setting of 38400 is required for
use with Rane controllers (i.c., RPM 88/44/22). It can be restored
by holding the encoder in during power-up for several seconds until
the encoder LED turns on.

5. This parameter sets the minimum time in milliseconds the re-
mote waits after receiving a RW 485 message before it transmits a
response. It is recommended that this value not be changed. The
default setting can be restored by holding the encoder in during
power-up for several seconds until the encoder LED turns on.

6. Maximum Number of Selections configures the number of selections

that can be accessed by the encoder (Knob Push & Turn and/or
Knob Bump). This parameter is ignored if both parameters 2 and 9
are disabled.

7. Knob Push & Turn Selection Roll configures the action taken when

the last (bottom) selection is reached and the encoder is pushed an
turned. When enabled, the selection wraps around from last to first
(or first to last, depending on encoder direction. This parameter is
ignored if parameter 2 is disabled.

8. Knob Push & Turn Update on Release configures when the selection

index is updated after the encoder is pushed in and turned. When
enabled, the SR updates its selection index when the encoder is
released, rather than updating each time the encoder is turned. This
parameter is ignored if parameter 2 is disabled.

9. Auto Selection - Knob Bump configuration affects the result of

bumping the encoder (pushing and releasing the encoder without
turning). When enabled, the next selection is automatically chosen;
the selection index is updated after the update timer expires. Selec-
tions automatically roll from last to first. Configuration of this
parameter affects the commands IS and ISR. See Encoder Input
Commands section for details.

10. Knob Bump Update Timer determines how long the remote waits
before updating its selection index once the encoder is released. Set-
ting this value to 0 updates the index instantly, with every press/re-
lease combination of the encoder. Increasing this value allows users
to scroll through and preview selections without updating the index
on every press. This parameter is ignored if parameter 9 is disabled.
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